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Introduction to ArcMap 10.2  

Fauquier County, VA 

This section provides an introduction and overview to ArcMap, which is the central application 

used in ArcGIS. ArcMap is where you display and explore GIS datasets for your study area, 

where you assign symbols, and where you create map layouts for printing or publication. 

ArcMap is also the application you use to create and edit datasets. 

ArcMap represents geographic information as a collection of layers and other elements in a map. 

Common map elements include the data frame containing map layers for a given extent plus a 

scale bar, north arrow, title, descriptive text, a symbol legend, and so on. 

Typical tasks performed in ArcMap 

ArcMap is the primary application used in ArcGIS and is used to perform a wide range of 

common GIS tasks as well as specialized, user-specific tasks. Here is a list of some common 

workflows you can perform: 

 Work with maps—you can open and use ArcMap documents to explore information, 

navigate around your map documents, turn layers on and off, query features to access the 

rich attribute data that is behind the map, and to visualize geographic information. 

 

 Print maps—you can print maps, from the simplest to very sophisticated cartography, using 

ArcMap. 

 

 Compile and edit GIS datasets—ArcMap provides one of the primary ways that users 

automate geodatabase datasets. ArcMap supports scalable full-function editing. You select 

layers in the map document to edit and the new and updated features are saved in the layer's 

dataset. 

 

 Use geoprocessing to automate work and perform analysis—GIS is both visual and 

analytical. ArcMap has the ability to execute any geoprocessing model or script as well as to 

view and work with the results through map visualization. Geoprocessing can be used for 

analysis as well as to automate many mundane tasks such as map book generation, repairing 

broken data links in a collection of map documents, and to perform GIS data processing. 

 

 Organize and manage your geodatabases and ArcGIS documents—ArcMap includes 

the Catalog window that enables you to organize all of your GIS datasets and geodatabases, 

your map documents and other ArcGIS files, your geoprocessing tools, and many other GIS 

information sets. You can also set up and manage geodatabase schemas in 

the Catalog window. 

 

 Publish map documents as map services using ArcGIS for Server—ArcGIS content is 

brought to life on the web by publishing geographic information as a series of map services. 

ArcMap provides a simple user experience for publishing your map documents as map 

services. 

 

http://resources.arcgis.com/en/help/main/10.2/00sm/00sm00000003000000.htm
http://resources.arcgis.com/en/help/main/10.2/01m5/01m500000003000000.htm
http://resources.arcgis.com/en/help/main/10.2/002s/002s00000001000000.htm
http://resources.arcgis.com/en/help/main/10.2/0066/006600000449000000.htm
http://resources.arcgis.com/en/help/main/10.2/00sq/00sq00000089000000.htm
http://resources.arcgis.com/en/help/main/10.2/00sq/00sq00000089000000.htm


3 | P a g e  
 

 Share maps, layers, geoprocessing models, and geodatabases with other users—

ArcMap includes tools that make it easy to package and share GIS datasets with other users. 

This includes the ability to share your GIS maps and data using ArcGIS Online. 

 

 Document your geographic information—A key goal in GIS communities is to describe 

your geographic information sets to help you document your projects and for more effective 

search and data sharing. Using the Catalog window, you can document all of your GIS 

contents. For organizations who use standards-based metadata, you can also document your 

datasets using the ArcGIS metadata editor. 

 

 Customize the user experience—ArcMap includes tools for customization, including the 

ability to write software add-ins to add new functionality, to simplify and streamline the 

user interface, and to use geoprocessing for task automation. 

Throughout this manual, the user can expect to find the most common tools and toolbars 

provided with a description of what the tool or toolbar is used for; what functions can be 

executed using the tool.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://resources.arcgis.com/en/help/main/10.2/0066/00660000045n000000.htm
http://www.arcgisonline.com/
http://resources.arcgis.com/en/help/main/10.2/0066/006600000449000000.htm
http://resources.arcgis.com/en/help/main/10.2/003t/003t00000001000000.htm
http://resources.arcgis.com/en/help/main/10.2/014p/014p00000025000000.htm
http://resources.arcgis.com/en/help/main/10.2/00v0/00v000000014000000.htm
http://resources.arcgis.com/en/help/main/10.2/00v0/00v000000014000000.htm
http://resources.arcgis.com/en/help/main/10.2/002s/002s00000001000000.htm
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How to start ArcMap: 
 

To start ArcMap the user needs to first access verify that ArcGIS 10.2 is loaded onto their 

computer by identifying the ArcGIS 10.2 icon from the START menu or on the desktop:  

 

 
 

Once in ArcMap, the user can being the process of creating custom maps or used for viewing 

geospatial data.  Most spatial data will be in the form of a shapefile or geodatabase, but spatial 

data can also be a table, a CAD drawing file, or the multiple file formats used with spatial data 

collectors (GPS data collector). 

 

How to create a map:  
 

Start ArcMap by double-clicking on the ArcMap icon on your desktop. If an icon is not present, 

you can use the Start Menu instead. Usually, you will find ArcMap if you click on: 

 

START BUTTON> PROGRAMS> ARCGIS> ARCMAP 10.2  
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b) When the “Getting Started” window pops up, the user can create a new map from scratch or 

open an existing or previously viewed map.  All previously opened maps will be displayed in the 

blank space with the title of the mapping project displayed. 

 

c) Select “Cancel” to start a new mapping project if you are not going to use an existing mapping 

project. 

 

 

 
 

 

The ArcMap Graphical User Interface (GUI) will look something like what you see below. If it 

looks slightly different, it’s because additional functionality (toolbars, etc.) may have been 

turned on or enabled by a previous user. When ArcMap is closed, it “remembers” these settings 

and restores them when it is reopened. 

 

Explore the ArcMap Interface. As you hold the mouse pointer over a button, a description of its 

function will appear in a small box below it. Additionally, a brief explanation of what it does will 

appear in the status bar in the lower right corner of the ArcMap GUI. Take a few minutes to try 

out this technique. As you mouse over some of the icons and buttons, try to familiarize yourself 

with what each one does. 

 

Some of the major “areas” of the ArcMap interface are labeled below. 
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Toolbars: 
 

Toolbars in ArcMap, found under the “Customize” tab at the top of your map window, are sets 

of tools that perform similar types of functions.  The Tools toolbar includes tools for navigating 

around the map display and tools for performing basic query functions.   When opened, all 

toolbars will present in a free floating state, meaning they will appear on the screen and you can 

move them around as you see fit.  You should know that all toolbars are dock able as well.  

Select and hold the heading of the toolbar and drag the toolbar around your screen to dock the 

toolbar on the panel at the top, bottom, side of the screen for better organization. 

 

When you save your .mxd and return to your map at a later date, or when you start a new map, 

your interface will appear the same as you left it during your previous session.  This helps saves 

time with loading toolbars or remembering what processing tools where used to create your map.   
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Try moving the Tools toolbar around the ArcMap window. You can even drag it to a location on 

your desktop that’s completely off the ArcMap GUI; just try not to lose it! 

 

The most common toolbars used will follow with an explanation of what each icon (tool) on the 

toolbar with performs when selected. 
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The Standard Toolbar: most typically appears at the top of the ArcMap application window 

and is used for map printing, creating a new map, opening an existing map, saving your map, 

starting related ArcGIS applications, and more. 

 

 

 

Button Name Function 

 

 
New map file Creates a new map 

 

 
Open Opens an existing map 

 

 
Save Saves the current map 

 

 
Print Prints the current map 

 

 
Cut Cuts the selected element(s) 

 

 
Copy Copies the selected element(s) 

 

 
Paste Pastes the clipboard contents into your map 

 

 
Delete Deletes the selected element(s) 

 

 
Undo Undoes the last action 

 

 
Redo Redoes the previously undone action 

 

 
Add Data Adds new data to the map's active data frame 

 

Scale 
Define a scale by manually entering it into the Scale 

box 

 

 
Editor toolbar 

Shows the Editor toolbar so you can edit the map's 

data 

 

 
Launch ArcCatalog Starts ArcCatalog 

 

 
Show/Hide ArcToolbox Shows/Hides the ArcToolbox window 

 
 

What's This? 

Allows you to get help for a menu command or tool 

by clicking the What's This pointer and clicking the 

menu command or tool 
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Tools Toolbar: is where the zoom in/out, pan and select tools can be found.   

 

 

 

 

Button Name Function 

 

 
Zoom In 

Allows you to zoom in to a geographic window by clicking 

a point or dragging a box 

 

 
Zoom Out 

Allows you to zoom out from a geographic window by 

clicking a point or dragging a box 

 

 
Fixed Zoom In Allows you to zoom in on the center of your data frame 

 

 
Fixed Zoom Out Allows you to zoom out on the center of your data frame 

 

 
Pan Allows you to pan the data frame 

 

 
Full Extent Allows you to zoom to the full extent of your map 

 

 
Back Allows you to go back to the previous extent 

 

 
Forward Allows you to o forward to the next extent 

 

 
Select Features Allows you to select features by clicking or dragging a box 

 

 
Clear Selected Features 

Deselects all of the currently selected features in the active 

data frame 

 

 
Select Elements 

Allows you to select, resize, and move text, graphics, and 

other objects placed on the map 

 

 
Identify Identifies the geographic feature or place on which you click 

 

 
Find Finds features in the map 

 

 
Go To XY Allows you to type an x,y location and navigate to it 

 

 
Measure Measures distance on the map 

 

 
Hyperlink Triggers hyperlinks from features 
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The Identify button, on the Tools toolbar, can be very handy – it will report to you all of the 

attributes for any feature that you click on in your map. By default it works on the top-most 

visible layer in your TABLE OF CONTENTS, but you can set it to identify features from a 

specific layer, from all visible layers, or from all layers.   

 

Click on the IDENTIFY button in the TOOLS TOOLBAR, and then click somewhere in your 

map. If roads are visible, then you will get information for whatever feature you clicked on – a 

road or a town. 

 

Experiment with drawing a box with the IDENTIFY button (this will give you multiple results) 

and with changing the layers that the tool works on. 
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Editor Toolbar: contains the various commands you will need to edit your data. From the Editor 

Toolbar, you can start and stop an edit session, create new features and modify existing ones, and 

save your edits.  

Button Name Function 

 

 Edit 
Selects and edits features and 

their geometries 

 

 Sketch Adds points to the edit sketch 

 

 Intersection 
Intersects two line segments to 

create a new point 

 

 Arc Creates a circular arc segment 

 

 Midpoint 
Creates a new point at the 

midpoint of a line 

 

 Endpoint Arc Creates a circular arc segment 

 

 Tangent Constructs a tangent curve 

 

 Distance-Distance 

Creates a point at the 

intersection of two distances 

from two other points 

 

 Direction-Distance 

Creates a point at the 

intersection of a direction from 

one point and a distance from 

another point 

 

 Trace 
Adds points to the edit sketch by 

tracing existing features 

 

 Split Tool Splits a linear feature 

 

 Rotate Tool Rotates the selected feature 

 
 Attributes 

Shows the feature property 

editor 
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 Sketch Properties 

Shows a dialog box for editing 

properties of the edit sketch 

geometry 

 

How to Find Tools: 

There are two basics ways to find tools: 

 Search using the Search window. 

 Browse using the Catalog or ArcToolbox window. 

In addition, tools can be found on menus and toolbars. ArcGIS is installed with a few commonly 

used tools on the Geoprocessing menu, and you can add tools to any menu or toolbar. 

Using the Search window to search for tools 

To open the Search window, do one of the following: 

 Click Geoprocessing > Search For Tools. 

 Click the Search  button. 

 Click Windows > Search. 

 Press CTRL+F. 

 

 

 

Tool home page 

As illustrated below, the Search window has four filters: All, Maps, Data, and Tools. Both 

the All and Tools filters will return tool results. When searching for tools, the best results are 

obtained using the Tools filter. 

The Search window Home page button  takes you to the geoprocessing tools home page, 

illustrated below. The home page lists all installed system toolboxes. You can click the toolbox 

name to examine the contents of the toolbox—its toolsets and tools. Custom toolboxes 

(toolboxes that you create) can be examined by clicking the Find My Custom Toolboxes link. 
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Note: Only those custom toolboxes in folders that you index can be found in 

the Search window. To add a folder to the search index, click the Indexing Options button .

 

 

Searching by name or 

keyword 

If you know the name of 

a tool, you can enter it in 

the Search window. If 

you don't know the name 

of a tool but can think of 

some words that 

describe what you want 

the tool to do, you can 

enter the words and 

search for all tools that 

match the words. 
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Tip: 

You can type the first few letters of a tool name to populate the drop down list. You can then 

highlight an entry in the drop down list using the up and down arrow keys or your mouse. 

Once you've highlighted the tool, press CTRL+ENTER to open the tool dialog.

 

 

Working with a search result 

There are a number of things you can do with a search item. If you pause the pointer on the 

item, a short description of the toolbox, tool, or geoprocessing package will be displayed 

(toolsets do not have descriptions), as illustrated below. The Item Description link in the short 

description will open the description of the toolbox, tool, or geoprocessing package. You can 

also open the item description by clicking the first line of text below the tool name. 

 

In addition to the Main menu and the Standard toolbar, the Desktop applications have other toolbars that 

contain commands to help you perform a group of related tasks. 
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Hiding and Showing Toolbars 

Toolbars are easily repositioned by dragging them to your desired location. Toolbars can either 

float on the desktop or dock along the outer edges of the application. You don't need to be in 

customize mode to move a toolbar. 

Toolbar visibility and position information are stored in the Normal template by default. 

Therefore, all documents that are based on the Normal template—the default—experience the 

same toolbar layout. The toolbar layout from the previous session is fully restored after you 

restart the application; toolbar information is automatically maintained, so you do not need to 

press the Save document button. 

Steps: 

1. Click Customize on the main menu and point to Toolbars. 

2. Check a toolbar to show it. 

 

3. Optionally, uncheck a toolbar to hide it. 

 

Note: You can access the toolbars list without using the Customize menu. Simply right-click 

anywhere in the toolbar docking area at the top of the application or directly on a toolbar. 
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How to add data: 
 

Now that you know what tools you will be working with and how to locate them it’s time to 

identify how to find and add spatial data to a new map document or an existing map document. 

The first button you need to know about… 

There are actually two buttons you need to know about but the first leads to the second. Identify 

the black plus sign with the yellow triangle behind it.  It will look like the following: 

  

Use this button to add layers to your map. Click on the button to reveal the Add Data Window: 

 

From this dialog, you will use the “connect to folder” button to navigate to your user storage 

folder or the Fauquier County geodatabase folder to add data.   

There are five types of data that you will be using: 

 points (vector)  

 lines (vector)  

 polygons (vector)  

 grids (raster)  

 imagery (raster) 
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Using Folder Connections 

It's a good idea to organize GIS content into a set of commonly used workspace folders. These 

are file folders on disk used to organize your GIS projects. They contain map documents, layers, 

file geodatabases, geoprocessing tools, scripts, and so on. 

An initial task in using the Catalog window is to establish a series of connections to the 

workspace folders whose content you plan to work with in ArcGIS. Each map has a Home 

folder, which is the folder in which the map document is stored. You can use the Home folder as 

the common location for organizing many of the contents used in your map document, such as a 

file geodatabase and its datasets, layer files, and other GIS information related to your map. 

 

Steps for creating additional folder connections 

The Catalog window gives you a mechanism for connecting to and working with GIS 

information in a number of workspace folders. The initial task is to establish a folder connection 

to each. 

 

1. Navigate to the Folder Connections node in the catalog window tree. 

2. Right-click the node and choose Connect To Folder. 

 

 

3. Type the path or navigate to the desired workspace folder and click OK. 

 

Tip: 

You can create a new folder connection by dragging a folder from the tree view onto the 

Folder Connections node. 

 

Working with folder connections in the Catalog window 

Once you have established a folder connection, you can use the Catalog window to navigate 

the contents of the folder. For example: 

 Double-click a map document to open it in ArcMap. 

 Add data to ArcMap by dragging datasets and layer files into the data frame. Use the same 

procedure to add items to a geoprocessing tool or into Model Builder. 

 Right-click an item and select Item Description to view its metadata. 

 

A feature that ESRI has added in ArcGIS 10.2 is the ability to add 3D basemaps to your globe 

document, which are accessed from ArcGIS Online. Basemaps change the way you want the 

overall globe to appear and may consist of one or many layers. The gallery of basemaps includes 

the key ArcGIS Online basemaps, such as World Imagery, World Streets, and World 

Topographic Map, as well as the Bing Maps services and many more. These basemaps all 

http://resources.arcgis.com/en/help/main/10.2/0066/006600000451000000.htm
http://resources.arcgis.com/en/help/main/10.2/0066/006600000451000000.htm
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require an Internet connection for them to be drawn in your globe. This makes it quick and easy 

to immediately add great basemaps to your view without having to download or manage the data 

locally. The content in these services is frequently updated, too. 

Click the  drop down arrow next to the Add Data button and click Add Basemap  
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Coordinate Systems and Map Projections: 
The Earth is not a perfect sphere.  Different Spheroids (Earth models) have been devised to 

model the earth- they are distinguished by the length of their axes. Different coordinate systems 

and map projections are used to account for the Spheroid of the Earth. Projected Coordinate 

Systems mathematically transform the 3 dimensional earth so that it can be modeled in 2 

dimensions.   

 

 To display your data correctly, each data frame uses a coordinate system. It determines the map 

projection for the map display in the data frame. The data frame's coordinate system need not be 

the same as the data you are using, although if ArcMap has to project your data on the fly, it can 

take longer to draw. 

When ArcMap is started with a new, empty map, the coordinate system for the default data 

frame is not defined. The first layer added to an empty data frame sets the coordinate system for 

the data frame, but you can change it if necessary. As you add subsequent layers, they are 

automatically displayed using the data frame's coordinate system as long as the data source's 

coordinate system is defined. 

If there isn't enough information, ArcMap will be unable to project the data in each layer and 

display it correctly. In this case, you'll have to supply the necessary coordinate system 

information yourself. 

Generally, if you have a layer whose dataset does not have a coordinate system defined and you 

know which coordinate system it is using, you should use the Define Projection tool in 

ArcToolbox to assign projection information to your data. This is required for working with that 

data in ArcGIS. 

 

In Fauquier County we utilize the VA State Plane Coordinate System.  State Plane-  a coordinate 

system that divides the United States, Puerto Rico and U.S. Virgin Islands into >120 zones. VA 

State Plane NAD83 is used by most local data providers and what most data used in Fauquier 

County is project in. 

 

Project Coordinate System: NAD1983 State Plane Virginia North FIPS 4501 Feet 

Projection: Lambert Conformal Conic 

 

 Tip: To see if your data source has a coordinate system defined, right-click the layer in the ArcMap table 

of contents, and click Properties to open the Layer Properties dialog box. Click the Source tab, then look in 

the Data Source box. You can also use the Catalog window to see if your data has a coordinate system 

defined. 

How to identify a layers coordinate system 

1. Right click on the title of your layer in the Table of Contents of ArcMap.  Choose Properties at 

the bottom of the pop up menu. 

2. Click on the Source tab.  

http://resources.arcgis.com/en/help/main/10.1/0017/001700000077000000.htm
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3. Scroll down the Data Source section, there should be a label that says Geographic Coordinate 

System or Projected Coordinate System.  This tells you which Coordinate System this map layer 

uses. 

4. Check all of your other Map Layers to make sure that they are using the same Coordinate 

System.  If not, use the directions below to change the Coordinate Systems to match one another. 

 

 

 
 

Table of Contents: 
 

Every map has a table of contents. The table of contents contains entries for the data used in the 

map.  The table of contents is used primarily to turn layers on and off, access the properties of 

layers, and rearrange layers to change the drawing order. You can display the table of contents 

with the Display, Source, or Selection tabs.  
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The Display tab shows the layers in each data frame with the layers sorted by drawing order. 

Layers at the top of the list are drawn on top of layers lower in the list. You can drag layers up 

and down in the list to control the drawing order. In the example graphic, the hillshade.img raster 

layer draws under the other layers since it's at the bottom of the list of layers. 

 

The Source tab shows the layers in each data frame with the layers organized by the folders or 

databases in which the data sources referenced by the layers can be found. This view will also 

list tables that have been added to the map document as data.  

 

The Selection tab shows a list of the layers in the active data frame and lets you check the ones 

you want to make selectable. This tab works like the Set Selectable Layers dialog box accessed 

from the Selection menu. 

 

You can adjust the look of the table of contents. For example, you might change the text size and 

font so that it makes a greater visual impact or is easier to read, or you might want to change the 

shape of the lines and patches that represent the features on a map. You can also dock the table 

of contents to the ArcMap interface, or you can make it a floating window as in the graphic 

above. 

*If you ever accidently close the table of contents, open the “WINDOWS” tab located at the top 

of the map and select table of contents.  The will table of contents will appear as a free floating 

window.  Dock the window to the left side of the screen. 
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Attribute Table: 

Tabular information is the basis of geographic features, allowing you to visualize, query, and 

analyze your data. In the simplest terms, tables are made up of rows and columns, and all rows 

have the same columns. In ArcGIS, rows are known as records and columns are fields. Each 

field can store a specific type of data such as a number, date, or piece of text.  

 

Feature classes are really just tables with special fields that contain information about the 

geometry of the features. These include the Shape field for point, line, and polygon feature 

classes and the BLOB field for annotation and dimension feature classes. Some fields, such as 

the unique identifier number (ObjectID) and Shape, are automatically added, populated, and 

maintained by ArcGIS. 

 

 
 

 

ArcGIS allows you to associate records in one table to records in another table through a 

common field, known as a key. You can make these associations in several ways including by 

joining or relating tables temporarily in your map or by creating relationship classes in your 

geodatabase that maintain more permanent associations. For example, you could associate a table 

of parcel ownership information to the parcels layer, since they share a parcel ID field. 
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To access the attribute table, right click the selected layer in the table of contents and select 

attribute table. 

As an aside, the following will provide examples of the importance of attributes and the attribute 

table: 

There are many mapping, analysis, and data management tasks you can perform using tabular 

data.  

 

Tables allow you to map and visualize your data. For example, you can classify or categorize 

attributes to symbolize a layer. You can use population values to symbolize major cities with a 

larger symbol than used for smaller towns and villages. You can also specify that a different 

color be used to represent each type of land use in a parcel layer. In addition, you can also use 

the attribute values to generate text to label each parcel feature. In the graphic below, the parcels 

are symbolized by the type of land use, and then labeled with their parcel ID values.  

 

, 

 

 

When information in your geodatabase changes, you can update your attributes when in an edit 

session.  For example, you'll need to update your database when land uses or property ownership 

changes—or the unknown values are classified. If you have a feature class representing some 

pipes with a field for the diameter, you can easily change the attributes when the crew removes 

an eight-inch and replaces it with a six-inch pipe. You can edit tabular values either within the 

table window or the Attributes dialog box, which shows attributes of only individual selected 

features. 

 

 

 

 

How to select features: 
 

It may seem strange to focus on the task of selecting features based on their attributes or location, 

but in fact, making selections is a very useful way to examine your data, and is a frequent first 

step in analyses.  For example, if you were working on a project based in a specific town, your 

first step might be to zoom to that town in your view. You could do that by first selecting the 
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town, and then choosing to zoom to your selected feature. Your next task might be to sub-set a 

number of statewide datasets (such as roads or streams) to just the area of your town. To 

accomplish this, you would also need to first have your town selected. 

 

Use Select Features Tool 

If it’s not already open, open ArcMap and the map you were working on earlier: Exercise1.mxd. 

 

Click on the SELECT FEATURES tool on the TOOLS toolbar, and then click on a feature in 

your map.  

 

Any feature or features that you selected should now be outlined in bright turquoise. 

 

Set Selectable Layer(s) 

 

Particularly when using the Select Features tool, it can be very difficult to figure out what you’ve 

selected once you have clicked somewhere. In the step above, you may have selected some roads 

and a town or two with just one click of the tool. There is, however, a handy way to control what 

can get selected: the List by Selection tab. 

 

 
 

Click the 4th icon from the left at the top of the TABLE OF CONTENTS – the List By Selection 

tab. 

 

The “regular” TABLE OF CONTENTS view shows you which layers are visible and in what 

drawing order; the “List by Selection” view instead shows you which layers are able to be 

selected and how many features in each are currently selected. 

 

Select features in the Attribute Table 

In an attribute table, you can select features by clicking on the small gray box at the far left of a 

row. You can click on just one row, drag down for several rows, or hold down the Ctrl key to 

select multiple rows. 
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Experiment with selecting towns by clicking on the gray box at the left. You can clear your 

selection by clicking the gray box in the very upper left hand corner, or by clicking the CLEAR 

SELECTION button at the top of the table. 

 
 

Select By Attributes 

 

The Select by Attributes dialogue lets you write a query to select features based on the values in 

the attribute table. 

 

Click the SELECT BY ATTRIBUTES button at the top of the table window. 

 

Select all of Addison County by the following steps: 

   i. Double click on the field “CNTY” 

   ii. Single click on the = operator 

   iii. Click the GET UNIQUE VALUES button 

   iv. Double click on the number 1 (for Addison County) 

 

Your statement should read: SELECT * FROM Boundary_TWNBNDS WHERE: "CNTY" = 1 

(Note that by clicking on the options as instructed above, you avoid having to know 
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whether/where to use single quotes/double quotes, etc. You are much better off doing it this way 

than trying to type the statement in the dialog window!) 

 

Click APPLY, then CLOSE. All of the towns in Addison County should now be selected. 

For more guidance on writing selection queries, click the HELP button in the SELECT BY 

ATTRIBUTES dialog.  ArcGIS’s Help is actually remarkably helpful, and frequently gives very 

useful examples. Queries can be more complex than the ones we use here – combining multiple 

expressions, incorporating wild- cards, involving calculations, and so on. The help text gives 

many examples that may be quite useful to you. 

 

 

Labeling features: 

Generally, labeling is the process of placing descriptive text onto or next to features on a map. In 

ArcGIS, labeling refers specifically to the process of automatically generating and placing 

descriptive text for map features. A label is a piece of text on the map that is dynamically placed 

and whose text string is derived from one or more feature attributes.  
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In ArcGIS: 

 Label positions are generated automatically.  

 Labels are not selectable.  

 You cannot edit the display properties of individual labels. 

Labeling is useful to add descriptive text to your map for many features. Labeling can be a fast 

way to add text to your map, and it avoids you’re having to add text for each feature manually. In 

addition, ArcMap labeling dynamically generates and places text for you. This can be useful if 

your data is expected to change or you are creating maps at different scales. 

The fastest and easiest way to label your data is to right click the layer in the table of contents 

and select label features.  The process with label the data based on data that is in the attribute 

table.   

The change the information used to label your data: 

1. Right click on the layer in the table of contents. 

2. Select properties 

3. Select the Labels Tab 

4. From here you can change how features are layered using the Label Field box 

 

Adding X/Y data from a table: 
 

In addition to data sources, such as a shapefile, you can also add tabular data that contains 

geographic locations in the form of X, Y coordinates to your map. 
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X, Y coordinates describe discrete locations on the earth's surface such as the location of fire 

hydrants in a city or the points where soil samples were collected. You can easily collect X, Y 

coordinate data using a global positioning system (GPS) device. 

 

To add a table of X, Y coordinates to your map, the table must contain two fields, one for the x-

coordinate and one for the y-coordinate. The values in the fields may represent any coordinate 

system and units such as latitude and longitude or meters. 

 

 
 

In ArcMap:  

Select Add XY Data… from the Tools menu 

In the Add XY Data window: 

Choose a table… Browse to your X-Y data file 

X Field = <Longitude field> (whatever your E-W field is named) 

Y Field = <Latitude field> (whatever your N-S field is named) 

 

For the Spatial Reference of Input Coordinates | Description:  

(by default this will say “Unknown Coordinate System”)  

Click on Edit (below the Description box) 

In the Spatial Reference Properties window, press Select 

In the Browse for Coordinate System window browse to the appropriate 

coordinate system 

Coordinate System used for MCB-Quantico: 
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Geographic Coordinate Systems | World | WGS 1984 

Projected Coordinate Systems | UTM | Nad1983 | NAD 1983 UTM Zone 

18N 
Press Add 

Back in the Spatial Reference Properties window, press OK 

Back in the Add XY Data window, press OK 

 

Once you have added the data to your map, it becomes an XY event layer and behaves like other 

point feature layers. For instance, you can decide whether you want to display it, symbolize it, 

set the visible scale, or display a subset of features that meet some criteria. 

 

If the table on which an XY event layer is based does not have an ObjectID field, you won't be 

able to perform certain tasks on the layer, this is okay because you can bring the data into your 

mapping session and perform the following task: 

 

Export data to a shapefile (right-click on the X-Y data layer in the Table of Contents and choose 

Data | Export Data… 
 

In Export Data window: 

Check Use the same Coordinate System as this layer's source data 

Rename and/or change the storage location of the new shapefile  

as desired in the Output shapefile box 

 

Click OK 

 

Saving a map and exiting ArcMap: 

After you finish working on a map, you can save it and exit ArcMap. You save a map as a 

document and store it on your hard disk. If you haven't saved the map before exiting, you'll need 

to name it, preferably with a name that adequately describes its contents.  If using the “X” in the 

upper right corner of the window to exit the program, ArcMap will automatically prompt you to 

save your mapping document if you have not already done so. 

ArcMap automatically appends a file extension (.mxd) to your map document name.  

 

The data displayed on a map is not saved with it. Map layers reference the data sources in your 

GIS database. It is good practice to not move data around on your hard disc as you may disrupt 

the link between data that is displayed in a map (referred to as data source).  If you do move data 

around and lose your data source connection, you can easily fix this in ArcMap.   

Repairing broken links for a single layer: 

If you only want to repair a broken link for one particular layer, click the Set Data Source 

button on the Source tab of its Layer Properties dialog box. This lets you specify the 
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layer's data source by browsing to it. When you click this button, ArcMap repairs only 

the current layer, even if the data sources of other layers that need repairing can be found 

in the location of the data source you specify. 

The other option is to right click the data layer in the table of contents.  Scroll down and 

select “repair data source” and identify the location of the data in the pop-up window. 

1. Locate the layer with the broken link in the table of contents.  

2. It will have a red exclamation mark next to it, and its check box will be unavailable.  

3. Right-click the layer and click Properties.  

4. Click the Source tab.  

5. Click the Set Data Source button, navigate to the data source you want, and click Add.  

6. Click OK. 

 

Repairing broken links for multiple layers:  

You may find that several layers in your map need repairing. For example, if a folder 

containing data sources that are used for multiple layers in your map has been moved or 

renamed; all these layers will need to be repaired. If you want to repair several layers at 

once, use the Repair Data Source command from the layer's context menu. 

 

With Repair Data Source, ArcMap repairs the selected layer using the data source you 

browse to and also automatically repairs other broken layers if it can find their data 

sources in the location of the data source you specified. 

1. Locate the layer with the broken link in the table of contents.  

2. It will have a red exclamation mark next to it, and its check box will be unavailable.  

3. Right-click the layer, point to Data, and click Repair Data Source.  

4. Navigate to the data source you want and click Add.  

ArcMap repairs the layer using the data source you specified and also automatically 

repairs other broken layers if it can find their data sources in the location of the data 

source you specified. 

It's always a good idea to save your map periodically while editing it. 

 

 

Saving your map  

1. Click the Save button  on the Standard toolbar.  If you haven't saved the map 

before, you'll need to name it 
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Adding Text to a map:  

 This is a process of adding text as a graphic (not the same as labeling) to your map to 

help provide more detail or highlight a specific area of your map.  These graphics can be moved 

around your map and manipulated to achieve the look you are going for. 

Maps convey information about geographic features, yet displaying only features on a map—

even with symbols that convey their meaning—isn't always enough to make your point. Adding 

text to your map improves the visualization of geographic information on your map. 

There are various kinds of text you can add to your map.  

Descriptive text can be placed near individual map features. For example, you might add the 

name of each major city in Africa to your map. You can also add text to draw attention to an area 

of the map such as the general location of the Sahara Desert. You can also add text that improves 

the presentation of your map. For example, a map title provides context; you might also consider 

adding other information such as map author, data source, and date. 

 

Symbology: 
 

One of the most powerful functions in ArcMap is the ability to symbolize data in a variety of 

ways. Changing Symbology or changing the way a feature appears in a map can help that feature 

stand out or play a supporting role in your map.  For example, if you don’t like the 

symbols/colors for roads, locate the symbol below the feature heading in the table of contents 

and double click it.  You will open the following window: 
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From here you can change the color, line weight, line type or create your own symbol for roads.  

If your map looks busy or confusing, try changing the symbology of features to highlight or mute 

certain features.  These steps can be performed on any feature data that is in the table of contents; 

all points, lines, and polygons can have their symbology changed. 

 

 

Data View and Layout View: 

ArcMap provides two ways to view a map: 

 Data view  

 Layout view  

Each view lets you look at and interact with the map in a specific way. 

 

When you want to browse the geographic data on your map, choose data view. Data view is an 

all-purpose view for exploring, displaying, and querying the data on your map. This view hides 

all the map elements on the layout, such as titles, north arrows, and scale bars, and lets you focus 

on the data in a single data frame, for instance, editing or analysis. 

 

Double click the symbol below the “roads” feature 

heading to open the symbol selector window. 
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When you're preparing your map's layout, you'll want to work with it in layout view. In layout 

view, you'll see a virtual page on which you can place and arrange map elements, and you can do 

almost everything you can in data view, plus design your map. 
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You can toggle between data and layout view easily.  Simple select either the data or layout view 

icon on the bottom left of the work frame in either view.  The red square above identifies these 

icons.  The data view icon resembles an “earth” image and the layout view resembles a “page” 

icon.   

The user can use the following to toggle between each view using the menu bar as well. 

Switching to data view  

1. Click the View menu.  

2. Click Data View.  

The ArcMap window displays the active data frame 

 

Switching to layout view  

1. Click the View menu.  

2. Click Layout View.  

The ArcMap window displays the entire map. 
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Setting Map Scale: 

You can specify the scale of your map by either typing in a value or choosing one from a list. 

When you specify a scale, the map is zoomed to that scale.  

 

There are many ways you can enter values into the scale box. You can simply type a number 

with or without comma separators, you can type a 1: and a number, you can paste values into the 

box, or you can type a relative scale. If you type a relative scale, for example, 1 cm = 100 m, 

then ArcMap will calculate an absolute scale for you. 

 The "1:" prefix can be present or absent:  

1:1,000,000  

1,000,000  

 Any character or word can be used as the separator in an absolute scale specification:  

1:25000  

1 - 25000  

1 to 1000  

1/1000  

 Thousand separators can be present or absent:  

1,000,000  

1000000  

 The values can be specified in reverse order:  

1:1,000,000  

1,000,000:1  

1 in to 5 mi  

5 mi to 1 in  

 "One" can be given as a number or a word:  

1:1,000,000  

One to 1,000,000  

One inch = 5 miles  

 Relative formats are supported. When relative scale formats are specified, you can use 

the following unit abbreviations: 

in  

pt  

ft  
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yd  

mi  

nm  

mm  

cm  

m  

km  

dd  

dm 

 In relative formats, you can also specify units using their full name. The scale control 

recognizes units by the first part of their names, so it doesn't care whether unit names 

are in plural or not. You can type any characters after the first part of the names shown 

here (* = wildcard characters):  

inch*  

poin*  

feet*  

yard*  

mile*  

naut*  

mill*  

cent*  

mete*  

metr* 

kilo*  

decima*  

decime* 

 In relative formats, any word or character can be used for "equals". A space isn't required 

between the value and the units abbreviation.  

1 in equals 500 mi  

5 inches = 500 miles  

500mi to 1in  

100 miles for 1 inch  

 

 

You will see two additional options in the drop-down list when you are specifying a scale on a 

dialog box: 

 <None>: Choose this option to clear the scale so that no scale is used. As a shortcut to 

choosing <None> from the list you can type "0", "none", or "<None>".  
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 <Use Current Scale>: If you choose this option, the current scale of the active data frame 

as it is displayed in the current view will be automatically inserted into the field. This 

makes it very easy to set the scale to be the same as the current scale you are using. So 

if you choose this option when the current scale of the data frame in your map is 

1:45,678 that value will appear in the scale field. 

 

Creating a Mapbook in ArcGIS 10.2: 
 

Data Driven Pages gives you the ability to generate a set of output pages by taking a single 

layout and iterating over a set of map extents. The extents are defined by the features in a layer 

and are sometimes called tiles, sections, or areas of interest (AOI). The layer that defines the 

extents is referred to as an index layer. Any feature layer may serve as the index layer. You 

create and customize new Data Driven Pages using the Setup Data Driven Pages dialog box. 

This dialog box contains two tabs: Definition and Extent. You can activate this dialog box from 

the Data Driven Pages toolbar or from the Page and Print Setup dialog box. 

 

Setup Data Driven Pages dialog box 

 

Through the Definition tab, you can select the index layer that drives the geographic extent for 

each page. You can also choose fields to use to name and sort the pages. There are also 

optional settings for map rotation, spatial reference, page number, and scale. 
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Enabling Data Driven Pages 
 

The Enable Data Driven Pages check box enables Data Driven Pages for the current map 

document. Unchecking the check box disables Data Driven Pages functionality. This check box 

needs to be checked to create, view, and utilize Data Driven Pages. If you disable Data Driven 

Pages and click OK, all Data Driven Pages settings you made are cleared. Data Driven Pages 

utilize the default settings the next time you enable Data Driven Pages for this map document. 

 

Required elements for Data Driven Pages 

Four elements are required for the creation of Data Driven Pages. They are 

 Detail Data Frame 

 Index Layer 

 Name Field 

 Sort Field 

 

Detail Data Frame 

To create a series of Data Driven Pages, select a data frame from the Data Frame drop-down 

menu. The default Data Frame for Data Driven Pages is the active data frame. Only a single 

data frame can be selected as the main data frame. The map extent of the main data frame 

changes for each page in the Data Driven Pages series. These map extents are driven by the 

spatial extent of features within the index layer. 

This drop-down menu displays a list of data frames in the current map document. The map 

document may contain a single data frame or a number of data frames. Only one data frame can 

be selected for Data Driven Pages. This is the Detail Data Frame. You can choose any data 

frame in your map as the Detail Data Frame (as long as there is at least one layer in it). 

Index Layer 

To create a series of Data Driven Pages, select the index layer from the Layer drop-down list. 

The default index layer is the topmost polygon layer of the active data frame. The index layer 

defines the geographic extent of the main data frame for each page in the Data Driven Pages 

series. Each feature in the index layer drives, or defines, each page in the Data Driven Pages 

series. The geographic extent of the feature helps define the map extent of the Detail Data 

Frame for the page (this extent can be further customized on the Extent tab). Attributes of the 

index layer provide values for other Data Driven Pages parameters. 

 

This drop-down menu displays a list of layers from Detail Data Frame. You can choose any 

feature layer from the Detail Data Frame for the index layer, as long as there is at least one 

feature in the layer. You are not confined to using only polygon layers as the index layer. You 

can also use points and lines, as long as you use a feature layer. Nonfeature layers, such as 

raster layers, cannot be used for the index layer. There are two geoprocessing tools available 

from the Data Driven Pages toolset in the Cartography toolbox to help you create an index 

layer: Grid Index Features and Strip Map Index Features. 

 

http://resources.arcgis.com/en/help/main/10.2/0070/00700000000q000000.htm
http://resources.arcgis.com/en/help/main/10.2/0070/00700000000r000000.htm
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When using point features, if you want to use only one map scale for each page, choose 

the Center and Maintain Current Scale option. Then, after exiting the Setup Data Driven 

Pages dialog box, set the scale of the Detail Data Frame to the scale you want. If you want 

different scales for different point features, you need to use a field containing these values and 

select Data Driven Scaleon the Extent tab and choose this field. You cannot use a layer from 

another data frame, another map document, or a stand-alone layer file (.lyr) as an index layer. 

The index layer must be a feature layer. You cannot use raster-based layers as the index layer. 

You should see a message box when creating Data Driven Pages and the index layer has more 

than 2,000 features. You can still create the pages, but be aware that performance may be 

adversely affected when dealing with such a large number of pages. 

You may want to label adjacent grids on your layout. In a map book, this would be the same as 

labeling adjacent, or neighboring, pages. Using dynamic text, you can navigate through the 

pages of your map book and have the labels identifying neighboring pages update 

automatically. You can use the geoprocessing Calculate Adjacent Fields tool to create the data 

you can use to label adjacent pages. 

 

Name Field 

Each page in the map series needs a name, and the names are taken from this field. As Data 

Driven Pages iterates through the features in the index layer and each page is defined, the 

attribute value for the chosen name field is used as the page name. 

The page name can be displayed on the Data Driven Pages toolbar. This can also drive a 

dynamic text element in the layout. You can add dynamic text for the page name using 

the Page Textmenu item on the Data Driven Pages toolbar. Use the Page Name option. Or, 

you can apply the formatting tag <dyn type="page" property="page name"/> to an existing text 

element. 

Select the Name Field from the list in the Name Field drop-down menu. The default is the first 

field using the string "name" in the field name. If there is no field using "name" in the field 

name, Data Driven Pages will then use the first available valid field. You do not have to use the 

default. You can choose to use a different field by selecting it from the drop-down menu. 

This drop-down menu displays a list of applicable fields from the index layer. This list includes 

fields from a table joined to the index layer. These include short integer, long integer, and 

string. 

To avoid confusion when working with Data Driven Pages, you should choose a Name field in 

which all values are unique. However, this is not required, and Data Driven Pages will accept 

null and duplicate values for Page names. 

Sort Field 

Pages in the map series need to be sorted. There needs to be a first page, a last page, and all the 

pages in between. The sort field provides the sorting logic and index for the pages. The first 

page of the series, or page 1, is determined based on the values of this field and whether the 

sort is in ascending order or not. The index always starts with 1 and ends with the number of 

pages created. This index changes when you change the sort field or refresh the pages after 

editing the sort field values. 

http://resources.arcgis.com/en/help/main/10.2/0070/007000000009000000.htm


42 | P a g e  
 

Since sort order is required for Data Driven Pages to work, a default field is chosen each time a 

new index layer is selected. The default is the first field using the string "PageNumber" in the 

field name. In many cases, you may want to apply your own page number values. Often, these 

values also match the order in which you want to sort your pages. Again, these values may or 

may not match the page index number. If there is no field using "PageNumber" in the field 

name, Data Driven Pages will then use FID or ObjectID. 

You do not have to use the default. You can choose to use a different field by selecting from 

the drop-down menu. The drop-down menu displays a list of applicable fields from the index 

layer. This list includes fields from a table joined to the index layer. These include short 

integer, long integer, float, double, date, and string. 

The page index can be displayed on the Data Driven Pages toolbar. For example, you might 

see "14 of 20". This means you are looking at the 14th page of 20 pages. This can also drive a 

dynamic text element in the layout. You can add dynamic text for the page index using 

the Page Text drop-down menu on the Data Driven Pages toolbar. Use the Page with 

Count option. Or, you can apply the formatting tag Page <dyn typePage Text="page" 

property="page index"/> or <dyn type="page" property="page count"/> to an existing text 

element. 

Page index is also reflected in the export dialog box. When you export Data Driven Pages using 

a page range, you are exporting pages based on their location in the index. The page index may 

or may not be the same number as the page number. The page index is internally generated, 

always begins with 1, and ends with the total number of pages. Page numbers can be 

alphanumeric, begin after 1, and end with a number greater than the total number of pages (this 

might be done to account for inserted pages in the final product). 

Data Driven Pages will accept null and duplicate values in the Sort field, but you should try to 

avoid this whenever possible. 

Optional Fields 

The Data Driven Pages setup provides three optional fields that you can use to further 

customize your pages. These fields must be an attribute of the index layer or field from a table 

that is joined to the index layer. They are 

 Rotation 

 Spatial Reference 

 Page Number 

Rotation 

There are some use cases where you want to apply a map rotation to specific pages or all pages 

in your map series. For example, a common type of map series or map book that requires map 

rotation is a strip map. A strip map often follows a linear feature. To make such a map series 

more readable, the map's page orientation is such that the linear feature draws from top to 

bottom and is centered on the page. This requires that the data frame be rotated. Though you 

can use any numerical index layer field to apply rotations to Data Driven Pages, you may want 

to consider using the Strip Map Index Features geoprocessing tool to create an appropriate 

index layer. This tool creates a new index layer that contains a field with appropriately 

calculated values for rotation based on your input. 

http://resources.arcgis.com/en/help/main/10.2/0070/00700000000r000000.htm
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Add this new layer to your map document and use it as the index layer for the Data Driven 

Pages. Select the appropriate field as the rotation field. As Data Driven Pages iterates through 

each page, an appropriate map rotation is applied to the Detail Data Frame based on the values 

of this field. If the value is null, Data Driven Pages uses a value of 0. Map rotation moves in a 

counterclockwise direction. If the value is negative, the rotation is clockwise. 

If you do not want to apply different map rotations to your pages, or want to use only the 

rotation value specified on the General tab of the Data Frame Properties dialog box (for the 

main data frame), do not specify this field. 

You can also use the Calculate Grid Convergence Angle geoprocessing tool to create values 

that can be used to rotate the map to true north for each map page in your series. 

This drop-down menu displays a list of applicable fields from the index layer. This list includes 

fields from a table joined to the index layer. These include short integer, long integer, float, and 

double. 

Spatial Reference 

There may be cases where you want to use specific spatial references for specific pages in your 

map series. You have three different ways to apply spatial references in Data Driven Pages. 

One way is to use the entire spatial reference string. This way, you can customize spatial 

reference parameters as you see fit. 

Here is an example of a spatial reference string for geographic coordinate system WGS 1984: 

GEOGCS["GCS_WGS_1984",DATUM["D_WGS_1984",SPHEROID["WGS_1984",6378137,

298.257223563]],PRIMEM["Greenwich",0],UNIT["Degree",0.0174532925199433]] 

A drawback to using the spatial reference string is that it can be very long and cumbersome. It 

is too large to store in a shapefile. Another way to apply spatial references is to point to a 

projection file on disk, if you have one. This can be a file local to your machine or a file on a 

network. You need to have the proper permission to these files. 

Here is an example of the path to the WGS 1984 projection file: 

C:\MyProjectionFiles\WGS 1984.prj. 

The last way to apply spatial reference is to use factory codes. A factory code is an integer 

identifier that is unique by coordinate system. Custom coordinate systems have a factory code 

of 0. Factory codes can be stored as either short or long integers. 

The factory code for geographic coordinate system WGS 1984 is 4326. 

When you specify a Spatial Reference field, values from this field define the spatial reference 

of the main data frame for each page in the Data Driven Pages series. If the value in this field is 

null, incomplete, or otherwise unusable, Data Driven Pages ignore the field and apply the last 

spatial reference used to the current page. 

There are two geoprocessing tools available from the Data Driven Pages toolset in the 

Cartography toolbox to help you populate a spatial reference field: Calculate Central Meridian 

and Parallels and Calculate UTM Zone. 

If you do not want to apply different spatial references to your pages, or want to use only the 

spatial reference specified on the General tab of the Data Frame Properties dialog box (for the 

main data frame), do not specify this field. 

http://resources.arcgis.com/en/help/main/10.2/0070/00700000000n000000.htm
http://resources.arcgis.com/en/help/main/10.2/0070/00700000000m000000.htm
http://resources.arcgis.com/en/help/main/10.2/0070/00700000000m000000.htm
http://resources.arcgis.com/en/help/main/10.2/0070/00700000000p000000.htm
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This drop-down menu displays a list of applicable fields from the Index Layer. This list 

includes fields from a table joined to the Index Layer. These include short integer, long integer, 

and text. 

Caution: 

If you select a field for Spatial Reference, create Data Driven Pages (by clicking OK) then 

decide you do not want to use the field to drive spatial references, you cannot simply choose 

none from the drop-down list to go back to a default spatial reference. There is no default 

spatial reference. Data Driven Pages always uses the last valid spatial reference if one is not 

supplied. You must manually change the spatial reference to get the data frame back to the one 

you want. 

Page Number 

Data Driven Pages also allows you to define a page number. The page number can be based on 

field values of the index layer. These values can be alphanumeric. For example, you can use 

Roman numerals or numbers with dashes to number your pages. If you are inserting pages 

between maps, you may be skipping page numbers as you populate this field. 

These page number field values can be used to drive dynamic text in the map layout. You can 

add dynamic text for the page index using the Page Text drop-down list on the Data Driven 

Pagestoolbar. Use the Page Number option. Or, you can apply the formatting tag Page <dyn 

type="page" property="page number"/> to an existing text element. 

Page number may or may not be the same as page index. In many cases, you will want the first 

map in your map book to be on the page after page 1. You may also want gaps in the page 

numbering to allow for inserted pages. 

For example, suppose you are designing a map book where there will be pages for 10 map 

features. You want the map book to include a title page, a table of contents, and an overview 

map, and you want tabular information to be inserted between each map page. You need to 

incorporate a number of files to get this final product. One of these documents is the map with 

the Data Driven Pages for the 10 map features. To account for the anticipated pages at the 

beginning of the map book and the inserted page between each map page, add a Page Number 

field to the index layer and populate the field as follows (the features have already been sorted 

accordingly). 

Page number 

Page 4 

Page 6 

Page 8 

Page 10 

Page 12 

Page 14 
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Page 16 

Page 18 

Page 20 

Page 22 

You select this field from the page number drop-down list and create your data driven pages. 

Please note the difference, as highlighted by the table below, between page index/page with 

count and the page number. 

Page index Page number Page with count 

1 Page 4 1 of 10 

2 Page 6 2 of 10 

3 Page 8 3 of 10 

4 Page 10 4 of 10 

5 Page 12 5 of 10 

6 Page 14 6 of 10 

7 Page 16 7 of 10 

8 Page 18 8 of 10 

9 Page 20 9 of 10 

10 Page 22 10 of 10 

This is an optional field. The drop-down menu is filtered to display applicable field types. This 

list includes fields from a table joined to the index layer. These include short integer, long 

integer, double, and text. 

Page numbers should be unique, though Data Driven Pages accepts null and duplicate values. 

Starting page number 

In some cases, you may want to start the map series pages at a page other than the first page. 

For example, you may want the first three pages in your map book to be for a title, a table of 
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contents, and an overview map. The maps (the results of the Data Driven Pages PDF export) 

actually begin on page four. You enter 4 in the Starting Page Number text box on the Data 

Driven Pages Setup dialog box. If you have a dynamic text element for page numbers in your 

layout, you should see Page 4 displayed for the first map page. Remember, since this is the first 

map, the index number for this page is 1. If you wanted to export only this page, you would use 

1 to identify the page in the Page Range text box even though the page number is 4. 

Here is a breakdown of page index, page number (dynamic text), and page number with count 

(dynamic text) for a map series of 10 maps and the starting page number set at 4. 

Page index Page number Page with count 

1 Page 4 1 of 10 

2 Page 6 2 of 10 

3 Page 8 3 of 10 

4 Page 10 4 of 10 

5 Page 12 5 of 10 

6 Page 14 6 of 10 

7 Page 16 7 of 10 

8 Page 18 8 of 10 

9 Page 20 9 of 10 

10 Page 22 10 of 10 

This option is only valid when page numbers are calculated internally. It is not valid when a 

page number field has been specified. 

Optional settings (Map Extent) 

The Extent tab allows you to define the margin between the edges of the data frame and the 

index feature for each page. There are three options: Best Fit, Center and maintain current 

scale, and Data Driven Scale. 
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Best Fit 

The Best Fit option provides a margin, measured along the horizontal or the vertical axis, 

between the edge of the data frame and the closet point of the index feature. The location of 

this closest point determines whether the margin is measured along the horizontal or the 

vertical. Other points of measurement may be larger than the specified fit. This is especially 

true for index features that are geometrically asymmetric or irregular. This is expected. 

A margin can be specified as a percentage, in map units, or in page units. 

A percentage value of 100 percent places the closest point of the index feature adjacent to the 

edge of the data frame. Values greater than 100 percent result in a margin between the feature 

and the data frame edge. The size, or distance, between data frame edges is calculated as a 

percentage of the distance, in map units, of the axis containing the closest point. For example, 

the closest point is along the vertical axis. The longest vertical length of the feature is 150 km. 

A margin percentage value set at 110 percent results in a data frame of (150 km * 110%) = 165 

km, with a margin of 7.5 km on either side. Since the distance between the feature and the data 

frame edge along the horizontal axis is farther, the margin will be greater than 7.5 km. Values 

less than 100 percent shrink the data frame to an extent that is within the extent of the index 

feature. 

Margins specified in map or page units are also measured from the edge of the data frame to the 

closest point of the index feature. Unlike percentage, the size value is applied to each side of 

the horizontal axis or the vertical axis. For example, a margin is set at 50 km. The closest point 

of the index feature is along the vertical axis. You should see a 50 km distance between the 

data frame edge and the closest part of the feature. At the other end of the axis, and along the 

horizontal, you will see margins greater than 50 km. You will see similar results if you choose 

page units to measure the margin. 
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Center and maintain current scale 

By choosing the Center and maintain current scale option, the detail data frame for each 

page in the Data Driven Pages series is centered on the center of the index feature and 

maintains a constant map scale. The map scale is set in the Scale text box on 

the Standard toolbar. 

 

Data Driven Scale 

By choosing the Data Driven Scale option, the map scale of the detail data frame for each 

page in the Data Driven Pages series is data driven. Use the drop-down list to select an 

appropriate field containing the data you want to use to determine scale. The drop-down list is 

filtered to display applicable field types. These include short integer, long integer, float, and 

double. 

When you specify a Data Driven Scale field, values from this field define the map scale of the 

detail data frame for each page in the Data Driven Pages series. If a value is null, Data Driven 

Pages uses the scale value of the previous page. Any fixed scale or a fixed extent associated 

with the detail data frame is ignored when Data Driven Pages are enabled. 

Data Driven Pages Defaults 

 Data Frame—The active data frame is used as the default data frame. 

 Index Layer—The topmost polygon layer of the active data frame is used as the default 

index layer. 

 Name Field—The first index layer field using the string "name" in the field name is used as 

the default name field. If there is no field using "name" in the field name, Data Driven Pages 

then uses the first available valid field. Valid field types for the name field include text, 

short integer, and long integer. 

 Sort Field—The first index layer field using the string "pagenumber" in the field name is 

used as the default sort field. If there is no field using "pagenumber" in the field name, Data 

Driven Pages then uses FID or ObjectId. 

 Optional Fields—None. 

 Map Extent—Best Fit option at 125%. 

 

How to create Data Driven Pages 

These steps assume that you already have an index layer with all the needed fields for 

customizing the pages. If you need to create an index layer or create data in the index layer for 

the customizations described above, you can use geoprocessing tools from the Data Driven 

Pages toolset. 

First, you should add the Data Driven Pages toolbar. The toolbar gives you access to the Setup 

Data Driven Pages dialog box, which you use to create your pages. You can also use the 

toolbar to navigate and refresh the pages, along with adding dynamic text for the page name or 

the page number. 

 

 

Adding the Data Driven Pages toolbar 

To add the Data Driven Pages toolbar click Customize > Toolbars > Data Driven Pages or 

click the Display Data Driven Pages toolbar button  on the Layout toolbar. 

http://resources.arcgis.com/en/help/main/10.2/0070/007000000008000000.htm
http://resources.arcgis.com/en/help/main/10.2/0070/007000000008000000.htm
http://resources.arcgis.com/en/help/main/10.2/00s9/00s900000036000000.htm
http://resources.arcgis.com/en/help/main/10.2/00s9/00s900000037000000.htm
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Creating Data Driven Pages 

1. Click the Setup Data Driven Pages button  on the Data Driven Pages toolbar. 

2. Click the Definition tab. 

3. Check the Enable Data Driven Pages check box. 

4. Check the default for Data Frame. If this is not the data frame you want as the main data 

frame for the Data Driven Pages, choose a different data frame from the drop-down menu. 

5. Check the default for Layer. If this is not the layer you want to use as the Index Layer, 

choose a different layer from the drop-down menu. 

6. Check the default for the Name Field. If this is not the field you want to use to name your 

page, then choose a different field from the drop-down menu. 

7. Check the default for the Sort Field. If this is not the field you want use to sort your pages, 

then from choose a different field from the drop-down menu. 

8. Select a field for Rotation if you want to apply a rotation to each page. Otherwise, you can 

leave the default value of none. 

9. Select a field for Spatial Reference if you want to apply a rotation to each page. Otherwise, 

you can leave the default value of none. 

10. Check the default for Page Number. If this is not the field you want to use to get the page 

number for each page, then choose a different field from the drop-down menu. 

Alternatively, choosing no field for page number will result with page numbers 

automatically generated from the Starting Page Number value. 

11. Click the Extent tab. 

12. Choose the extent option that you want to use. 

13. Click OK. 

 

Adding Page Name as dynamic text 

1. Click the Layout View button  to make sure ArcMap is in Layout view. 

Note: Dynamic text only works in Layout view. 

2. Click the Page Text drop-down menu on the Data Driven Pages toolbar. 

3. Choose Page Name from the list. 

4. Select the newly added text element and move it to the location you want it on the page 

layout. 

Adding Page Number as dynamic text 

1. Click the Layout View button  to make sure ArcMap is in Layout view. 

Note: Dynamic text only works in Layout view. 

2. Click the Page Text drop-down menu on the Data Driven Pages toolbar. 

3. Choose Page Number from the list. 

4. Select the newly added text element and move it to the location you want it on the page 

layout. 

Adding a dynamic text element for Page Number with Count (total pages) 

1. Click the Layout View button  to make sure ArcMap is in Layout view. 

Note: Dynamic text only works in Layout view. 

2. Click the Page Text drop-down menu on the Data Driven Pages toolbar. 
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3. Choose Page with Count from the list. 

4. Select the newly added text element and move it to the location you want it on the page 

layout. 

 

 

The section below will cover some of the more advanced geoprocessing features that 

ArcGIS has to offer that have yet to be covered in this training guide. 

 

How to create a street index: 

A street index is an extremely important part of the mapbook.  It helps the reader quickly identify 

page(s) that pertain to the purpose of their search.  In this portion of the training guide, I am 

going to walk you through a step-by-step process used to create a street index using only the data 

encompassed by your grid reference as well as how to associate those attributes to your index. 

For this example we will use structures and their associative data to create the index.  The end 

product should display building number, building name, and street address, coordinate address 

(grid based street address - optional), page number, and USNG page number in the index.  

Below I give a couple of examples of how to generate a street index using data driven pages and 

a spatial join. 

To accomplish this task we first want to limit our coverage area to only the grid squares that have 

structure data in them.  To accomplish this we will perform a select by selection analysis. 

1.) Select the Selection tab from the tool bar 

2.) Click on Select by Location 

3.) When the window opens, file the form out to display: 

a. Select features from existing structure area 

b. That have their centroid in 

c. USNG_6K 
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Now that all the grid squares containing structure data are selected, we want to create a layer 

from selected features to isolate this grid. 

4.) Create a layer from selected features 

a.  

 

1. Intersect the streets feature class with the map grid index feature class using the spatial join 

tool. 

2. Use the streets layer as the Target Features and the map grid index layer as the Join 

Features. Set the Join Operation to One-to-Many. Leave the rest of the options as default. A 

new feature class is created. 

3. Open the new feature class’ attribute table and add a new text field. 

4. Concatenate the Street Name and the PageNumber fields (Field Calculate using [NAME]& 

"-"& [PageNumber]). 

5. Summarize based on the new field. (In the open attribute table, right click the concatenated 

field and select Summarize.) Doing this removes the duplicate entries. Select any other 

summarizations that might be helpful. 

6. Open the created dbf file in Excel and make changes as needed. Print or convert this table to 

the desired format and add it to the Map Book. 

 

 

Definitions: 
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Absolute accuracy: exact correspondence between the location of features in map data and 

their actual positions on the earth. 

Attribute accuracy: the difference between information recorded as digital map data or database 

tables and the real-world features represented. For example, for map data that includes street 

names as attributes, the percentage of correct names would be the measure of accuracy. 

Attribute information: descriptive, non-graphic information recorded as digital map data or an 

associated database table. Examples of attributes are street names, street types (highway, side 

street, etc.), and pavement types. 

Cell: individual picture elements in a raster image. 

Complete/Completeness: a measurement of whether map data includes the features a user 

would expect to be represented. 

Control points: exact positions of often-surveyed geographic features used to register map 

sheets and transform coordinates. 

Currency: measures how recently the map data was collected, usually expressed the revision 

date. 

Data creators: companies that develop their own or enhance existing geographic data. 

Data integrators: companies that gather digital map  

data from a variety of public or private sources and adapt it for a specific mapping project and 

target software. 

Data packagers: companies that repackage existing map data, with very little customization, for 

mass distribution. 

Datum: a mathematical model that provides a smooth approximation of the earth’s surface. 

Digital Chart of the World (DCW): a digital database published by the US Defense Mapping 

Agency that contains maps of the entire world, input at a scale of 1:1,000,000. 

Digital elevation models (DEMs): a representation of the terrain in a given area, expressed as a 

rectangular array of regularly spaced elevation values. Also referred to as a Digital Terrain 

Model (DTM), or Digital Terrain Elevation Data (DTED). 

Digitizing: the process of converting existing data from paper maps-as well as drawings and 

aerial photos into digital form by (1) manually tracing the maps on hardware that consists of a 

digitizer tables and a cursor with crosshairs and keys used to record map features as X,Y 

coordinates or (2) scanning the map and using automatic conversion software to translate the 

resulting raster file to vectors and storing it directly in the GIS. 
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Display information: information that describes how digital map features will appear visually. 

Display information includes color, fill pattern, line type, and so on. 

Easting: the east-west, X, coordinate in a rectangular coordinate system. 

Feature Class - a collection of geographic features with the same geometry type (such as point, 

line, or polygon), the same attributes, and the same spatial reference. Feature classes can be 

stored in geodatabases, shapefiles, coverages, or other data formats. Feature classes allow 

homogeneous features to be grouped into a single unit for data storage purposes. For example, 

highways, primary roads, and secondary roads can be grouped into a line feature class named 

"roads." In a geodatabase, feature classes can also store annotation (label information) and 

dimensions. 

File format: the physical arrangement of digital data stored in a map file. 

Geodatabase - is the common data storage and management framework for ArcGIS. It combines 

"geo" (spatial data) with "database" (data repository) to create a central data repository for spatial 

data storage and management. 

Geographic coordinate system: a system of numeric coordinates used to locate and record 

specific positions on the earth’s surface. 

Geographic information: information in a digital map that records the physical position and 

shape of a map feature. 

GIS (geographic information system): a computer-based technology for retreiving, storing, 

and   organizing data based on its location on a map. 

Global Positioning System (GPS): satellite-based positioning technology that, with differential 

correction, can yield engineering-level accuracy. 

Hierarchical: a logical structure that classifies    information in a series of steps, starting with 

broad, simple classifications, and proceeding, in stages, to narrow, precise classifications. 

Hydrography: map data that describes the positions and characteristics of bodies of water. 

Hypsography: map data that describes the exact shape of the earth’s surface, usually in the form 

of contour lines, digital elevation models, or color shadings. 

Internal file format: the binary file format used      internally by a specific GIS platform. 

Latitude: the first component of a spherical coordinate system used to record positions on the 

earth’s surface. Latitude indicates the angular    distance north of south of the earth’s equator 

measured through 90 degrees (see “Longitude”). 
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Layers: a means of organizing and managing map data by type. Hydrological features (such as 

floodplains), parcel maps, railroads, and so on can be contained on separate layers for easy map 

creation and maintenance. 

Local Coordinate System: a system designed for a small geographic area. Local coordinate 

systems cannot be expanded to include large areas without loss of accuracy. Typically, local 

coordinate systems are not projected systems; they are X,Y-coordinate systems (e.g., State Plane 

Coordinate System). 

Longitude: the second component of a spherical coordinate system used to record east-

west    positions on the earth’s surface, measured in degrees as the arc or position of the earth’s 

equator intersected between the meridian of a given place and the prime meridian, which runs 

through Greenwich, England. (See “Latitude“) 

Mercator projection: a map projection designed by Gerhardus Mercator, where the earth’s 

surface is drawn as it would appear if projected on a cylinder wrapped around the earth. 

Metadata: information describing a data set. A    digital map’s metadata might state its 

scale,      revision date, author, accuracy standards, and other pertinent information. 

Northing: the north-south, Y, coordinate in a        rectangular coordinate system. 

Paper coordinates: coordinates measured directly from the paper on which a map is drawn, 

often recorded in inches or centimeters.  

Planar coordinate system: a coordinate system drawn on a flat surface, or plane. Planar 

coordinates are usually expressed as pairs of rectangular X, Y values. 

Prime meridian: the line of longitude that runs through Greenwich, England, used as the origin 

(zero point) for longitudinal measurements. 

Projection: a system to portray all or part of the earth, which is an irregular sphere, on a planar, 

or flat, surface. 

Raster: raster data takes an evenly spaced grid (like a piece of graph paper) and places a value in 

each square, or cell. Raster data is best suited for continuous data such as slope, rainfall, or the 

amount of light reflecting off the ground (as in a photograph). 

Rectification: the process of assigning spatial coordinates to a map data image by warping it to 

fit known geographic control points. 

Relative accuracy: the difference between how features on a map and those same features in the 

real world are positioned in relationship to each other. A measurement system may employ a 

“bias” or “systematic” error, with consequently inaccurate results, but still preserve local 

relationships. 
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Remote-sensing data: digital data collected by satellite and other airborne, electronic-[A1] 

imaging systems. 

Resolution: the minimum distance that can be recorded by a measurement system. For example, 

if a map has a resolution of 10 meters, the map cannot accurately depict features smaller than 10 

meters. Therefore, these features may be depicted as points, or they may not be depicted at all. 

Rubber sheeting: an editing method that corrects errors by stretching maps to fit known control 

points. 

Scale: the proportion or ratio between a map measurement and the corresponding measurement 

in the real world. Map scale is usually expressed as a ratio, such as 1:24,000, which means that 

a measurement of one unit on the map represents 24,000 units in the real world. 

Shapefile - is a digital vector storage format for storing geometric location and associated 

attribute information. 

Spherical coordinate system: a coordinate system measured on the surface of a sphere, usually 

expressed as angular distances.  

State Plane Coordinate System: a set of rectangular mapping coordinate systems defined in the 

United States. Each state is divided into one or more zones, and a separate coordinate system is 

defined for each zone. 

Transfer file formats: digital-data file formats specifically designed to transfer data between 

different systems such as DXF™ and SDTS. 

Transportation data: digital map data that describes transportation features, such as roads, 

railroads, or pipelines. 

Universal Transverse Mercator (UTM): a specific implementation of the transverse mercator 

projection, designed for common usage around the world. The UTM system divides the world 

into 60 east-west zones, each of which is six degrees of longitude wide. Each zone is projected 

individually. 

Vector: vector data is the storage of X, Y, Z coordinates connected to form points, lines, areas, 

and volumes. Vector data is best suited to store    discrete, well-defined data that can clearly be 

delimited. Location of oil wells (points), street   centerlines (lines), timber stands (areas), and 

groundwater tables (volumes) are good candidates for vector storage. 
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Shortcuts: 
 

Navigating with your mouse:  

Using the wheel mouse makes it easy to zoom and pan anytime you like without changing the 

tool you are currently using.  

 

These shortcuts work in data view and layout view. In layout view, they apply to the page by 

default. You can hold down Shift and perform any shortcut to apply it to the data frame instead 

of the page (the active data frame in the case of rolling the mouse wheel, or the data frame you 

clicked in the case of clicking or dragging the mouse wheel).  
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Mouse wheel action ArcMap navigation function 

Roll wheel back and forth Zoom in and out 

Hold down Ctrl and roll 
Zooms in and out but with finer increment. Use for 

small adjustments.  

Click mouse wheel (or middle mouse 

button) 
Center map at location where you clicked 

Hold down mouse wheel (or middle mouse 

button) and drag 
Pan 

Hold down Ctrl and click mouse wheel Center and zoom in at location you clicked  

Hold down Ctrl and drag with the mouse 

wheel 
Zoom in 

 

Rolling the mouse wheel is applied to whichever part of the user interface the pointer is currently 

over. In this way, you can just move the pointer over the map and roll the wheel to zoom in or 

out, regardless of which window or dialog box has keyboard focus.  

 

You can reverse the zoom in/zoom out convention used by the mouse wheel on the General tab 

of the ArcMap Tools > Options dialog box.  

 

You can use the middle mouse button on a three-button mouse instead of the mouse wheel for all 

the shortcuts except for rolling to zoom in and out. 

 

Temporarily changing any tool into a navigation tool  

Hold down the following keys to temporarily turn the tool you are currently using into a 

navigation tool:  

 Z = Zoom In  

 X = Zoom Out  

 C = Pan  

 B = Continuous Zoom/Pan (Drag with left mouse button zooms in/out, drag with right 

mouse button pans.)  
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These shortcuts work in data view and layout view. In layout view, they apply to the page by 

default. Hold down Shift as well as the key to apply it to the data frame you click on instead of 

the page.  

Re-centering the map with one click  

You can quickly re-center the map when you use the pan tools.  

 Click with the Pan tool re-centers the data frame at the location you clicked. 

 Click with the Layout Pan tool re-centers the page at the location you clicked. 

 

Continuous Zoom/Pan tool  

The Continuous Zoom/Pan tool can be added into any toolbar in the ArcMap user interface 

from the Pan/Zoom category of the Tools > Customize dialog box. This tool is especially useful 

if you want to have a dynamic zooming and panning capability but don't have a mouse with a 

wheel.  

 You can temporarily turn any tool into this tool by holding down the B key on your 

keyboard. The Continuous Zoom/Pan tool does not have to be added into your ArcMap 

user interface for this to be available.  

 You can reverse the zoom in/zoom out convention on the General tab of the ArcMap 

Tools > Options dialog box.  

 When this tool is active, you can re-center the map by clicking with the right mouse 

button, in addition to panning the map by dragging with the right mouse button.  

 The Continuous Zoom/Pan tool works on the page when you are in layout view. Hold 

down Shift to operate on a data frame when you are in layout view. 

Other navigation shortcuts  

 When the Zoom In tool, Zoom Out tool, or Pan tool is active, F6 toggles among these 

three tools. F6 also toggles among the corresponding three layout tools when you are 

in layout view.  

 The arrow keys scroll the map in the direction you press, unless a graphic or map 

element is selected, in which case they nudge that element.  

 The Home and End keys also scroll the map left and right. PageUp and PageDown 

scroll the map up and down. 

 The + and - keys zoom in and out, the same as the Fixed Zoom In and Fixed Zoom Out 

buttons. 

 The < and > keys zoom go back to the previous extent or forward to the next extent, the 

same as the Back and Forward buttons.  

 The Insert key takes you to the full extent, like the Full Extent button. 

 Hold down Alt and click the name of a layer in the table of contents to zoom to the extent 

of that layer. 
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Navigating with context menus  

Right-clicking the map in data view gives you a menu containing a set of commonly used 

commands. The menu includes some commands that operate at the location you right-clicked, 

enabling you to perform an operation once without changing your current tool. 

 

 
 

This menu doesn't appear if you right-click the map in data view when you are using certain 

tools, such as some of the editing tools, that have their own specialized context menus. However, 

you can customize the existing context menus of those commands to include any of the 

navigation commands.  

 

You can also access the navigation context menu when you are working with a viewer window. 

A viewer window lets you pan and zoom the contents of the window independent from the main 

ArcMap window. All the commands are available except for Go Back To Previous Extent and 

Go To Next Extent. 

 

You can also customize this menu to add additional commands into it as shortcuts, but remember 

that some commands only work in particular menus. For example, the commands in the context 

menu you get when you right-click a layer in the table of contents won't become enabled if you 

add them into other menus. 

 

 

References: 
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